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ULTRALOOP | LABEL CREDITS
A GIANT THANK YOU GOES OUT TO THE FOLLOWING LABELS WHO CONTRIBUTED TO PROVIDING 

THE ULTRALOOP SAMPLE MAPS.  ULTRALOOP DEFAULT MAP WAS CREATED BY ENIG’MATIK 

RECORDS ARTISTS:

The default ULTRALOOP sample map was created by:

Enig’matik Records Artists | http://enigmatikrecords.com/

The ULTRALOOP bonus sample maps were created by the following labels:

Loopmasters | http://www.loopmasters.com/

Sounds of Revolution | http://www.sounds-of-revolution.com/

The included ULTRALOOP library is free to use for commercial or non-commercial music, 
film and multi-media works by individuals (single users). You may not redistribute these 
samples in any way, shape or form or claim credit for the material in its raw unaltered form 
or outside of a greater body of work. You may not use this material to make other sample 
libraries. Click here to view the complete End User License Agreement online for this 
product online.

 Credits
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ULTRALOOP | ARTIST CREDITS
A GIANT THANK YOU GOES OUT TO THE FOLLOWING ARTISTS WHO CONTRIBUTED TO MAKING 
THE ULTRALOOP FACTORY SAMPLE MAP IN COLLABORATION WITH ENIG’MATIK RECORDS.  
PLEASE CHECK OUT THEIR WORK AND SUPPORT THEIR ART.

Apparition Chris Komus Dusty Fungus Fine Cut Bodies Flint Kids

Ion Driver Itsu KiloWatts Sun In Aquarius Whitebear

ULTRALOOP features additonal sound design and sample content by:

ANTONIO BLANCA | HTTP://WWW.ANTONIOBLANCA.COM/

JOSH HINDEN | HTTP://TWISTEDTOOLS.COM

SONICTWIST | HTTP://TWISTEDTOOLS.COM

The included ULTRALOOP library is free to use for commercial or non-commercial music, 
film and multi-media works by individuals (single users). You may not redistribute these 
samples in any way, shape or form or claim credit for the material in its raw unaltered form 
or outside of a greater body of work. You may not use this material to make other sample 
libraries. Click here to view the complete End User License Agreement online for this 
product online.

 Credits
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LEGAL

All software discussed in this manual is issued as is and the software described in this manual 
comes with no warranty. We are not be responsible for any lost data, hardware problems or 
financial loss incurred as a result of using this software. If you are unsure as to how to use this 
software, don’t use it. Any information in this manual is subject to change without notice and 
nothing in this document represents a commitment on the part of Twisted Tools, LLC.  All the 
software described by this document is copyright Twisted Tools. All product names and company 
names mentioned herein are ™ or registered trademarks of their respective owners. The software 
described by this document is subject to a License Agreement and may not be copied to other 
media. Click here to view the complete End User License Agreement online for this product online 
and read before using the included software or sample content. You may not alter this document in 
any form or distribute it for any purpose other than press related purposes. You may not share this 
software with anyone or any entity, such as torrent sites without violating the terms of use. Should 
you share this software illegally, it is likely that the wrath of god will come down upon you.  Should 
you buy this software, your karma will be plentiful. 

If you somehow magically obtained this software, buy it...at our site.  We need your support to 
keep bringing you more twisted tools. 

Twisted Tools™

San Francisco, CA

USA

 Legal
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TWISTED TOOLS | ULTRALOOP
USER GUIDE

1. Welcome
Thanks for purchasing ULTRALOOP. We hope you enjoying using this tool as much as we 
enjoyed making it. 

ULTRALOOP is a loop remixing sampler, designed to layer and composite rhythmic loops 
using the included factory library or your your own samples. Because you can load your 
own samples, ULTRALOOP is well suited to any style of music production or sound design 
task. 

At the heart of the ULTRALOOP interface is a fast and intuitive sequencer that allows you 
to visually layer and comp loops . While you can easily just hit random and drag some 
sliders around until you hear something you like, there are hundreds of different parameters 
and controls to work with should you choose to edit your loops with absolute precision.

Have fun!

Twisted Tools

1.1. Manual Conventions
This manual uses formatting conventions to point out facts, teach you tips and warn you of 
things.  

The following icons are found throughout this guide:

Important warnings. Always read these!

Notes: Useful notes and relevant additional information.

Tips: Tips and advanced techniques. 

Videos: Links to relevant videos.

Audio: Links to relevant audio.

           Welcome
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Links: Links to other content/websites with relevant info.

Single step instructions will be indicated with an arrow like the one on the left.

The following text formatting is used throughout this guide:

Text appearing in menus (New, Save, etc.) and file paths and file names will be Italic.
Text appearing somewhere on the interface, but not in a main Reaktor menu will be 

highlighted in BLUE. 

Important names, ideas and topic headings will be bold.

Key commands will be in brackets (e.g., “Press [Control]”)

Section links (e.g., links to other sections within the manual) will be indicated like 

this.

1.2. System Requirements
Mac or PC running the latest full version of Native Instruments Reaktor 5 
(Reaktor Player is NOT supported)
Intel Core 2 Duo Processor or better recommended
600MB of available RAM
iPad with the Liine Lemur application installed if you plan to use the included OSC 
template by Antonio Blanca
Approx. 1.25 GB of drive space
Internet connection for download

If you’d like to test your system before buying ULTRALOOP to see if it is fast enough, try 
the FM4 Dual ensemble (with all FX activated) included with your Reaktor default library. If 
you’re able to run the FM4 Dual ensemble comfortably and have at least 500MB of RAM, 
ULTRALOOP should run smoothly for most basic presets, keeping in mind that fast scene 
switching will require additional CPU as hundreds of controls will be recalled with each 
scene.

           Welcome
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1.3. Installation
ULTRALOOP is a Reaktor ensemble. There is no need 
to install a Reaktor ensemble. They are like Word 
documents, you can put them anywhere and double-
click them to open them or drag them to the Reaktor 
interface to open them.

That said, it is good practice to put them somewhere 
in your default Reaktor USER CONTENT location, 
which you can set in Reaktor > Preferences, within 
the DIRECTORIES tab.

Files that say .ENS should be put in the Ensembles 
sub-folder in your user library. Then you can easily 
browse for them from within the Reaktor browser 
window's user tab.

            Installation
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2. What is ULTRALOOP
ULTRALOOP, a first-of-its-kind loop remixing sampler with a fast and intuitive visual 
workflow for Native Instruments *Reaktor. ULTRALOOP combines advanced loop layering, 
comping, effect processing and automation techniques to generate new grooves, riffs and 
song ideas. You can use ULTRALOOP with the included factory sample library or to remix 
your own samples, injecting new life into any existing loop library. 

ULTRALOOP comes bundled with a ton of additional content, including an iPad *Lemur 
template by Antonio Blanca and a factory loop library by Enig’matik Records, Loopmasters 
and Sounds of Revolution.  A series of Ultraloop Expansion Packs are available separately 
and feature presets and loops by artists such as Si Begg, Dusty Fungus and Chris Carter.

*Reaktor Player is NOT Supported. 

2.1. How is it designed to work?
ULTRALOOP is a sampler that plays back pre-recorded loops (called samples) or loops 
that you load. It runs inside the full version of Reaktor in either plugin mode or standalone 
mode. 

Each time you hit play in Reaktor, ULTRALOOP will begin playing back various samples 
from the sample map and you can use a unique Track sequencer to determine which 
steps of the underlying loops are to be heard.

At the core of ULTRALOOP is an advanced loop layering engine and sequencer, capable 
of both layering and comping - a production technique that allows you to flip between 
layered tracks that are playing back simultaneously, by muting and un-muting slices of 
each layer. Up to eight tracks with loops of any BPM can be layered or comped together in 
real-time and can be further processed using an all-new Gestural FX engine. The Gestural 
FX engine automatically generates dynamic effect movements that ramp and modulate 
over time, using a suite of creative effects designed to produce endless fills, articulations 
and variations. 

To create additional loops and variations, ULTRALOOP features and endless supply of 
randomization functions, connected to a unique Preset Grid system for each main 
parameter group sliders.  A Preset Grid allows you to store, recall and automate settings 
by using a dynamic memory grid made up of 17 slots that can be played on-the-fly.  The 
settings for the entire instrument, including all the parameter Preset Grids can be stored 
and recalled in one of eight Global Scenes, allowing you to create infinite loop variations. 
All the relevant instrument features can be played with live, without skipping a beat, by 
using a mouse, MIDI or OSC.  

What is ULTRALOOP?
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2.2. ULTRALOOP Feature Highlights
Loop Remixing Sampler
Advanced layered sampler engine with intuitive interface
Visual loop compositing
Generative Gestural FX to create fills, articulations and variations
FX Sequencer
Specialized track sequencer with mono and poly draw modes
Layered playback and editing of up to eight tracks simultaneously
Independent controls per layer, organized into parameter cells with sliders
Automatable Preset Grids per parameter group, with 17 memory slots each
8 Global Scenes per snapshot
Preset Grids and Scenes are playable via mouse, MIDI or OSC
Extensive randomization options
Flexible multi-output routing per layer
Master Punch control
Swing
iPad Lemur OSC Template by Antonio Blanca
3+ banks of presets
2224 Sound Variations
Over 800mb of included factory sample content by from Enig'matik Records Artists, 
Loopmasters and Sounds of Revolution.
Sample content and sound design by:  Antonio Blanca, Apparition, Chris Komus, 
Dusty Fungus, Fine Cut Bodies, Flint Kids, Josh Hinden, Ion Driver, Itsu, Kilowatts, 
Loopmasters, Oliver Schmitt, Sounds of Revolution, Sonictwist, Sun in Aquarius 
and Whitebear
Optional Expansion Packs by cutting edge artists such as Dusty Fungus, Chris 
Carter and Si Begg

What is ULTRALOOP?
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3. Getting Started with ULTRALOOP
The following sections will give you a very quick overview of how to get going with 
ULTRALOOP. We will explain how to open ULTRALOOP and how to explore and use the 
default factory Snapshots (presets) and Scenes (sub-presets). Lastly, we’ll look at 
randomizing.

No doubt that ULTRALOOP is a deep instrument, but the central idea behind it is quite 
simple. 

ULTRALOOP works something like this:

When you hit play, ULTRALOOP begins playing back up to eight loops that are 
constantly running together in sync, following the current playhead position.
Drawing steps in the Track Sequencer allows you to visually choose which step of 
each loop should playback. 
Drawing steps in the FX Sequencer applies effects movements, called GESTURES, 
to all tracks that have FXON activated.
All the main parameters can be stored into one of 17 memory Slots using Preset 
Grids, which you can think of as single parameter Scenes that allow you to 
dynamically recall and modulate parameters.

3.1. How to Open ULTRALOOP

To open ULTRALOOP:

1. Start Reaktor in standalone mode or plug-in mode. 

2. In Reaktor’s file browser (View > Show Browser), click on the USER tab. 

If you didn’t install ULTRALOOP into your Reaktor User Library (Section 1.3), you can 
navigate to ULTRALOOP.ens using the ‘Disks’ tab or simply drag and drop 
ULTRALOOP.ens onto the main Reaktor window from its location on the hard drive.

Getting Started
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3. Double-click (or drag) ULTRALOOP.ens from the lower section of the browser onto the 
main Reaktor screen area and ULTRALOOP will be loaded and ready to play.

If you are in standalone mode, you may need to go to File > Audio & MIDI Settings to setup 
your audio and MIDI. If you are in plug-in mode, be sure your track is armed and your audio 
driver is setup.

3.2. Exploring Snapshots and Scenes

Snapshots

A Snapshot is basically a preset. You can change a snapshot by using the snapshot drop 
down in the Main Bar . You can hit play near the top of the interface or press [Spacebar] to 
start playing back a Snapshot. 

Be sure to turn on EDIT mode by clicking the structure icon next to the main snapshot 
menubar before beginning to work with ULTRALOOP if you plan on using your own 
samples and snapshots. Otherwise, you won’t be able to create snapshots and add your 
own samples.

Getting Started
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When in standalone mode, the BPM that was stored with the snapshot is automatically 
recalled. This ensures that the Snapshots playback at the right tempo they were created 
at. 

If you’d like to browse through a set of Snapshots using a different BPM, simply turn off 
SET BPM BY SNAPSHOT in the Reaktor Settings or run Reaktor inside your host.

If things are playing at the wrong pitch, it’s like because your DAW is set to a different BPM 
than that of the sample content. ULTRALOOP snapshots default to using ‘Pitch Stretching’, 
which changes the pitch of the samples to slow down or speed up to match the tempo. 
You can turn this feature off by using the PITCH mini-cell.  When off, ULTRALOOP uses a 
grid to slice the samples and retime the sliced positions to the current BPM. 

Selecting and Playing Scenes

Each ULTRALOOP Snapshot has eight Scenes. You can think of the Scenes as sub-
presets contained within each Snapshot that store and recall most of the controls, with the 
exception of the Global Controls found in the ULTRALOOP header. The Scenes can be 
changed using MIDI, OSC or by selecting a Scene with your mouse.

To select a Scene with your mouse:

Select a Scene by clicking the number buttons with your mouse.

The Scenes change and the settings and sounds associated with each Scene are 
recalled.

Getting Started
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To select and play a Scene with your keyboard:

Play notes C3 - G3 to select and play the Scenes on-the-fly.

The Scenes change and the settings and sounds associated with each Scene are 
recalled via MIDI

In Reaktor standalone mode, you can use your QWERTY keyboard to simulate playing a 
MIDI keyboard. 

You can change the default root note for scene playback from c3 to any other octave, by 
dragging the value next to the keyboard icon, but this will affect QWERTY keyboard 
playback which is centered around C3.

Randomizing Scenes

Clicking the Master RND button will randomize certain aspects of your Scene. Which 
aspects it randomizes depends on which areas are set to Master Random Receive. 
Throughout the interface you’ll find small green dots. These green dots are Master 
Random Receive toggles and determine whether that area is setup to receive 
randomization when using the Master RND button. 

You can toggle all areas on and off by clicking the green Master Random Receive Flip 
button in the master area shown below.  

To randomize various aspects of your Scene:

1. Select the BASIC Snapshot in the BASICS bank.

2. Click the Master RND button in the master section.

Notice how the sound changes and the effects change. This is because the LOOPS Cell 
and the FX GESTURES Cell have Master Random Receive on, as indicated by the 
green dot. 

Getting Started
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The Sampler parameters for each layer are laid out in a horizontal row as sliders and are 
grouped into cells by parameter type. You can think of each row as an independent sample 
layer with its own settings. The Loops sliders determine which samples are playing back for 
their respective tracks (1-8). 

The FX GESTURES squares are Memory Slots that store automatic effect movement 
patterns that are created each time you click GENERATE button . The gestures are applied 
everywhere there is an active FX SEQUENCER step (yellow) at the top of The Sequencer 
area and for each track that has FX ON active.

3. Next, click the Master Random Receive toggle button located beneath the TRACK 
SEQ Cell.

The Track Sequencer determines when the samples playing back should be un-muted. You 
can see the waveform below the Sequencer steps and choose which steps you’d like to 
listen to.

4. Click the Master RND button at the top of the interface.

Notice how the TRACK SEQUENCE, FX GESTURES AND LOOPS Parameter Groups are 
flashing, indicating that the parameters are being randomized when clicking the Master 
RND button. 

You can still use the individual Parameter Cell ‘Rnd’ buttons regardless of the Master 
Random Receive state. 

The horizontal axis of the RND buttons determines the strength of randomization. If you 
click to far to the left of the randomization button you’ll get very few steps in the resulting 
sequence.

Getting Started
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3.2.1. Saving Snapshots using the Sidepane

As you work, you’ll make modifications and changes to the Snapshots. Naturally, you’ll 
want to save these. In order to save Snapshots,  you’ll need to be familiar with the Reaktor 
Sidepane area. Be sure to turn on EDIT mode by clicking the structure icon next to the 
main snapshot menubar before beginning. 

For more detailed information on working with Reaktor snapshots, please read the 
Application Reference manual that comes with your Reaktor application.

Fig. 3.1 ULTRALOOP interface with Snapshot list in the Sidepane.

[1] Sidepane Button
[2] Snapshot drop-down menu
[3] Snapshot Banks 
[4] Snapshots area

Getting Started
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First, let’s look at how to select snapshots using the Sidepane:

1. Be sure the Sidepane is open, by clicking the Sidepane Button (1).

2. Next, be sure to select ENS - ULTRALOOP from the Snapshot drop-down menu (2) if 
it isn’t already selected. 

3. Choose a bank of Snapshots that you’d like to listen to from the Snapshot Banks (3).

4. Choose presets from the Snapshots area (4) below.

The Snaphot drop-down menu you set in step two above, allows you to choose 
ULTRALOOP’s Snapshots, or additional Snapshots for other instruments/effects you may 
be running inside of Reaktor alongside ULTRALOOP.  For example, you may choose to load 
some other ensembles to process ULTRALOOP. If you do, those ensembles have 
Snapshots as well and you will want to take note of which snapshots you’re actually 
editing, by keeping an eye on the Snapshot drop-down. 

Next, let’s look at the save options. 

At the bottom of the Snapshots area, you will see three buttons: APPEND, STORE and 
INSERT.  

APPEND: Creates a Snapshot in the next available free slot. 

STORE: Stores Snapshots by overwriting the current Snapshot.

INSERT: Inserts Snapshots in between other Snapshots, in a slot within any bank that you 
choose. 

Be sure you have ‘Ens - ULTRALOOP’ selected in the Snapshot drop-down menu. We 
recommend turning ‘Linked’ off to avoid confusion.  Linked will automatically select the 
Snapshot drop-down menu to be set to the last instrument you clicked.

3.2.2. Copy and Paste Scenes Between Snapshots

You can easily copy a Scene to another Scene by clicking the COPY and PASTE buttons, 
but did you realize that it’s also possible to copy Scenes in between Snapshots? 

For example, if you want to copy a sound from a specific Scene to another Scene in a 
different snapshot bank all you need to do is use Copy and Paste. 

To copy and paste a Scene from one Snapshot to another Snapshot:

1. Select a Snapshot and choose a Scene to copy. 

2. Click COPY.

Getting Started
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3. Change to a new Snapshot or a new Bank, such as the User bank.

4. Select a Scene that you’d like to use for the copied scene form Step 1.

5. Hit PASTE and then STORE your snapshot.

3.2.3. Snapshot Banks Described

There are plenty of Snapshots to help get you started with ULTRALOOP. Almost all 
Snapshots include eight Scenes as well, so don’t forget to check those out by switching 
Scenes as described earlier.  

If you’d like to initialize a Scene within a Snapshot, you can simply use the Scene INIT 
button found in the footer section to initialize any Scene.

ULTRALOOP’s Default Snapshot Banks are organized into the following 
categories:

BASICS - Default snapshots and basics to help learn about ULTRALOOP. 
ULTRALOOP 140 BPM - This is the Default Factory snapshot bank, featuring 
futuristic and highly detailed samples by various artists from Enig’matik Records. 
The samples were all recorded at 140BPM.
USER - We created this bank for your Snapshots. It is empty now, but hopefully it 
won’t be for too long! Go ahead, make some custom snaps - it’s easy! You can 
even copy/paste Scenes from our Snapshots to your own, using the Scene COPY, 
PASTE and STORE buttons to store your Snapshots.

ULTRALOOP comes with following two bonus banks, from Loopmasters and 
Sounds of Revolution sample library makers.

LOOPMASTERS - 128BPM - This is a collection of 75 EDM, dubstep and 
breakbeat inspired Snapshots and 128 royalty-free samples from Loopmasters at 
128BPM.
SOUNDS OF REVOLUTION - 127BPM - This is a collection of 75 house, techno 
and tribal inspired Snapshots using 128 royalty-free samples from Oliver Schmitt’s 
Sounds of Revolution at 127PM.

Getting Started
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3.2.4. Loading the factory Bonus Banks and your own Snapshots

The Bonus banks use both Snapshots and Sample maps and are located in your 
ULTRALOOP product download, inside the BONUS BANKS folder.  You must load both 
the sample map and the Snapshot bank to properly playback the Snapshots! 

To import the Snapshots, simply click the EDIT menu in the Snapshots Banks area and 
create a new bank. Then, choose LOAD BANK.  

To import the sample maps associated with the Snapshots, simply drag them to the 
sample map or Choose Sample Map > Import (Replace)... from the Sample Map Editor.

Be sure to backup your Snapshots and/or the entire ULTRALOOP ensemble before 
importing over an existing Snapshot bank! 

Be sure to turn on EDIT mode by clicking the structure icon (three squares) near the main 
menu bar before trying to create and edit Snapshots.

Additional Loop Expansion packs are available for sale at the Twisted Tools site. Loop 
Expansions are sample libraries of 128 loops, made by world class musicians and sound 
designers and can be used used with any program that accepts WAVs, such as Twisted 
Tools ULTRALOOP, VORTEX or ROLODECKS.  

3.3. Using your own samples
While the default sample map and presets should keep you busy for a long time, 
ULTRALOOP is a sampler that generates new loops using any sample content. Whether 
you’re using the included Bonus Banks, Ultraloop Expansion Packs or your own samples, 
at some point, you’ll want to load up your own sounds up and see what can be done. The 
more variety you put in, the more variety it will spit out. 

You can throw in loops of any tempo, but for the best quality we recommend using Loops 
of the same BPM and KEY.

Be sure to turn on EDIT mode by clicking the structure icon near the main menu bar before 
proceeding.

Opening the Sample Map Editor:

1. Click the wave icon located in the Reaktor Menu bar or go to VIew>Show Sample Map 
Editor [F9]

Getting Started
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The Sample Map Editor area will open which shows a list of all the samples what is called 
a Reaktor Sample Map. You can replace single sounds one at a time, add multiple sounds 
or replace the entire default sample map.

To replace a single sound:

1. Select the sound you’d like to replace.

2. Choose Replace from the Sample Map Editor.

3. When prompted, locate the sound you’d like to replace it with and click Open.

You can also drag from the file browser directly to the ‘Reaktor Sample Map Editor’. A red 
line will appear allowing you to insert the sample into the map at a specified position.

To replace multiple sounds at once:

1. Click the ‘L’ header in the Sample Map Editor so that the samples are displayed 
chromatically starting at sample 0.

2. Shift-select a group sounds you’d like to replace.

3. Choose Remove from the Sample Map Editor.

4. Drag the replacement sounds to the Sample Map Editor until you see a red insertion 
line appear at the desired position.

To replace the entire sample map:

1. Shift-select all the samples in the map.

2. Choose Remove from the Sample Map Editor.

3. Drag up to 128 samples to the sample map area.

Sometimes samples have loop points written into the actual file and looping turned on. This 
will cause problems with most Twisted Tools Reaktor samplers. Make sure Loop is off. 

Getting Started
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To save entire sample maps:

You may want to save Reaktor map files to use later or to load in other Reaktor 
instruments. 

1. Choose Sample Map > Export including Audio Data... from the Sample Map Editor. 

2. Save and name the document when prompted.

A file appears on your desktop called YOUR_NAME.MAP which contains all the samples. 
You can use a .map Reaktor file in nearly any Reaktor sampler capable of loading multiple 
sounds.

To load your sample map into Reaktor:

Choose Sample Map > Import (Replace)... from the Sample Map Editor or drag and 
drop your map onto the editor.

To create a sample map from a folder of samples:

Download the Reaktor Sample Map Generator by Choronzon using the following 
link. 

http://relivethefuture.com/choronzon/2008/01/15/reaktor-sample-map-generator/

This handy application will allow you to instantly create sample maps based on folders of 
samples. 

To use your samples within ULTRALOOP:

1. Make sure the ULTRALOOP LOOPS sliders are visible by clicking the Slider View 
button.

2. Drag the sliders around to select different samples from your map (0-127).

Use the numeric indicator in the upper right corner of the cell to see the sample 
number that corresponds to the sample number on the keyboard and list in the 
Sample Map editor.

Getting Started
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4. Overview of ULTRALOOP
In this section of the manual, we’ll examine the interface, look at basic signal flow 
principles and explain all the ULTRALOOP controls. 

There are two ways you can approach ULTRALOOP. You can hit random and drag sliders 
around until you hear something you like or you can spend time fine-tuning your sound 
combinations with precision. For starters, we recommend you begin exploring by looking 
at the Getting Started section to get familiar with Snapshots and Scenes.

4.1. The Interface

Fig. 4.1 ULTRALOOP User Interface.

[1] The Reaktor Master Header area: Contains Reaktor controls for selecting 
snapshots, turning on EDIT mode, setting BPM and more. See the Reaktor manual 
for more details.

            Overview

                                       ULTRALOOP USER GUIDE - PAGE 23



[2] The Ultraloop Master Header area: Contains all the ULTRALOOP Master 
controls and toggles, which aren’t specific to a Scene. 
[3] The Sequencer area: Features the Track, FX sequencers, FX Mixer and Mini-
Cells that give you additional settings per track.
[4] Sequencer and FX Controls area : Features Parameter Cells for the Track 
Sequencer, FX Sequencer and FX Gestures.  Preset grids allow you to store and 
playback up to 17 sequencer patterns and FX Gestures in memory slots, to make 
longer arrangements. You can select or automate the presets using MIDI, OSC or 
your mouse. 
[5] Sampler Controls area: Features several pages of Parameter Cells that have 
both Sliders and Preset Grids that control the sampler parameters and playback 
parameters. Preset grids allow you to store and playback up to 17 Slider settings in 
memory slots, to make longer arrangements and patterns. You can select or 
automate the presets using MIDI, OSC or your mouse.
[6] The Ultraloop Footer area: Contains the MIDI Mode selector and Scene 
controls. The Scenes controls are MIDI Root, Init Scene, Copy/Paste/Duplicate 
Scene and the Scene selectors.

4.2. Understanding the Basics
No doubt, ULTRALOOP is a deep instrument, but the central idea behind it is quite simple. 

ULTRALOOP works something like this:

When you hit play, ULTRALOOP begins playing back up to eight loops that are 
constantly running together in sync, following the current playhead position.
Drawing steps in the Track Sequencer allows you to visually choose which step of 
each loop to playback. 
Drawing steps in the FX Sequencer applies effects movements, called GESTURES, 
to all tracks that have FX ON activated. 
All the main parameters can can stored into one of 17 memory Slots using Preset 
Grids, which you can think of as single parameter Scenes that allow you to 
dynamically recall and modulate parameters.

4.2.1. Loop Selection

When you click the play button in the Reaktor Master Header area (or in your DAW), all the 
ULTRALOOP settings are loaded and the sampler engine starts to playback up to eight 
layered samples that loop repeatedly. 
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The loops selected for playback are determined by the Slider positions set inside the 
LOOPS Parameter Cell, found within in the Sampler Controls area. The values of each 
slider determine which samples in the Reaktor Sample Map to playback. 

See the getting started section for more details on working with Reaktor sample maps.

Of course there are many additional Sampler Controls that alter the sound of each layer 
and they can be accessed using the other Parameter Cells found in one of four 
Parameter Cell Pages, by clicking the tabs for TIME, SPACE,  FILT and ENV controls. 

We’ll look at the details that describe each Parameter Cell later in the manual. 

4.2.2. Sequencing and FX Processing

The the layers that are played back in ULTRALOOP can be sequenced and processed 
using the Track Sequencer, FX Sequencer and FX Gestures before reaching the 
output. 

The cyan colored sequencer in ULTRALOOP is the Track Sequencer, and it is not your 
typical sequencer! 
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It doesn’t re-trigger samples, the samples are always playing back, regardless of whether 
or not you draw any steps. You can visualize the waveforms that are playing back 
underneath each step and then select sections of the loops that you’d like to be audible, 
allowing you to comp together a performance when using MONO draw mode or stack 
slices on top of one another using POLY draw mode.

Using the FX SEQUENCER, you can then determine which steps will have have effects 
active and which tracks will be routed to the effects. The effects are generated 
automatically by using the FX GESTURE cell’s GENERATE button. FX Gestures are 
automatically generated dynamic effect movements which are stored in Memory Slots 
inside what’s called a Preset Grid. 

4.2.3. Preset Grids

If you click on the Slider View toggle  you will see the Preset Grid which represents 
the 17 memory Slots.  These slots are similar to Scenes, but store memory for only a 
single parameter.

Each Parameter Cell has Preset Grids. In the case of the Sampler Controls area 
Parameter Cells, the Memory Slots store slider positions. In the case of the Sequencer and 
FX Controls area, the Memory Slots store active Sequencer steps for the Track and FX 
Sequencers and FX Gestures (you won’t see these anywhere, as they’re automatically 
generated). The grey numeric readout in the upper right corner of the Parameter Cell 
indicates which Memory Slot you’re currently editing and you can drag it to change the 
slots. When you release the mouse, it snaps back to the center slot which you can think of 
as your custom default slot. 
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4.3. The Parameter Cells
In this section we’ll look at the controls you’ll find in the Sequencer and FX Controls 
area and the Sampler Controls area. 

The Sequencer and FX Controls area has Parameter Cells that only contain Preset Grids 
and related controls, while the Sampler Controls area has Parameter Cells that are made 
up of Sliders, Presets Grids and additional controls that can be used to adjust various 
settings for your loops. 

4.3.1. Working with the Parameter Cells

The Parameter Cells found in the Sequencer and FX Controls area have Preset Grids 
that store Sequences and FX Gestures into one of 17 Memory Slots. These Memory Slots 
can be selected, played, automated and randomized.  

The Parameter Cells found in the the Sampler Controls area also have Preset Grids. 
These Preset Grids store Sliders values into one of 17 Memory Slots and determine the 
settings for each sample layer. These Memory Slots can also be selected, played, 
automated and randomized. 

Let’s look at some examples to see what makes up a Parameter Cell.

Fig. 4.3.1 Parameter Cells

[1] Cell Label: Each cell parameter has a name that identifies it.  Most cell labels 
can be right-clicked to reset the sliders to their default state. 
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The ENV page has cell labels that can be clicked to change the cell you’re viewing and 
working with, though they are entirely independent cells and controls. Right-click these 
labels to reset the cell.

[2] Slider View Toggle: This button toggles between Slider View and Preset Grid 
view. 

[3] Slot Selector/Numeric Readout: Grey numbers represent the currently 
selected memory Slot # that you’re editing. Drag this number up/down to change 
memory Slot #. When dragging a slider in Slider View, this area will also double as a 
Numeric Readout that displays the current Slider or Slider Range values.

[4] Cell Slider: Sets the value for the Cell Parameter for that layer. Cell sliders 1-8 
correspond to Layers 1-8 (top to bottom). 

Cell Slider mouse behaviors: Click and drag from left/right to adjust the values. Double-click 
to isolate the slider from being affected by randomization or modulation. A purple indicator 
line indicates that it is isolated. Right-click to set to default and MIDI learn.

[5] Cell Range Slider: Sets the minimum and maximum values for the Cell sliders.

[6] Cell Randomizer: Randomizes the Sliders for all Memory Slots, unless Single 
mode is on.

Cell Randomizer mouse behaviors: Clicking on the left side of the randomizer randomizes 
less than clicking towards the right side which randomizes more.

[7] Master Random Receive Toggle: If on, clicking the Master RND button in the 
Master area will randomize this cell. If off, this cell won’t receive randomization when 
clicking the RND button in the Master area. 

[8] Single Edit Mode:  When Single Edit Mode is ON, the Random and Edit 
Functions will be applied only to the currently selected Slot, otherwise the Random 
and Edit functions will be applied to all 17 Memory Slots.  

When Single Edit Mode is OFF, you can isolate a Memory Slot from being edited by control-
clicking it. Use the Pin Mode button to select a slot to be isolated and then control-click it. 

[9] Edit Functions: COPY, PASTE and RESET for either all slots or a single slot, if 
Single Mode is active.
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You can COPY a single slot by using Single Edit Mode, then deactivate Single Edit Mode 
and PASTE to populate all Memory Slots with the same settings. This way you can quickly 
setup all Memory Slots to contain the same data, then make modifications to each slot to 
create variations. 

[10] Pin Mode: If Pin Mode is on, then the Memory Slots won’t snap back to the 
middle position when dragging around the Preset Grid and will stick to the last 
selected slot, even if there is Preset Grid automation taking place. 

Pin Mode is activated automatically when switching between Preset Grid view and Slider 
View so that you can edit a Slot without the Sliders jumping around. Once in Slider View, 
you can turn it off if you prefer to edit the Sliders as they automate. 

[11] Record Mode: Activates automation recording of the Preset Grid Memory Slot 
positions. Simply turn on Record and drag the Memory Slots around the Preset 
Grid and the movements are recorded. You’ll need to press the small Play button as 
well for the recorded Slot automation to play back. 

[12] Play Mode: Activates playback of the stored Preset Grid Memory Slot 
automation. Playback quantization will be determined by the global SYNC setting 
set in the Ultraloop Master Header area. 

[13] Preset Grid Automation Length: Determines the length of the Preset Grid 
automation. An indicator above the Cell indicates the length of the automated 
recording and shows the current playback position. Drag the value to adjust the 
length of the automation pattern in 1/16th note increments. L32 = 32 1/16th notes 
or two bars. 

[14] Preset Grid MIDI Root: Sets the Root Note setting for MIDI input to the 
Preset Grid. You can select, play and automate the Memory Slots via MIDI note by 
using a MIDI keyboard or your QWERTY keyboard. The Center Slot is the Root 
Note slot and the rest of the Slots increase chromatically from the lower left to 
upper right corner. Drag to adjust the Root note by octave and be sure that MIDI IN 
PLAYS: SLOTS is selected in the Ultraloop Footer area and that the Preset Grid 
MIDI IN is on by pressing the keyboard icon for each Preset Grid you want to 
respond to MIDI.

[15] Preset Grid MIDI IN: Activates MIDI in for any Parameter Cell’s Preset Grid. 
Works in conjunction with the MIDI Root setting and MIDI IN PLAYS: SLOTS must 
be active in the Ultraloop Footer area.
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[16] Preset Grid:  The default view for most Parameter Cells is the Preset Grid. 
The Preset Grid has 17 Memory Slots that store a single set of Parameters for that 
particular Parameter Cell. The slots can be manually selected, played back or 
automated. A Preset Grid is like a Scene for one parameter group of settings. 

4.3.2. The Sequencer and FX Controls Parameter Cells Defined

There are three Parameter Cells in the Sequencer and FX Controls area. They are the 
TRACK SEQUENCER, The FX SEQUENCER and the FX GESTURE Parameter Cells. 

TRACK SEQUENCER CELL - Stores the Track Sequencer steps into one of 17 Preset 
Grid Memory Slots that can be selected, played, automated and randomized. The Track 
Sequencer is the blue eight track sequencer found in the Sequencer area at the top of the 
ULTRALOOP interface. Each track represents a layer. 

Only the active sequencer steps are stored into a Memory Slot. None of the 
additional sequencer controls or Mini-Cell settings are stored in the Track 
Sequencer Cell. The additional settings are however stored in a Scene. 

FX SEQUENCER CELL - Stores the FX Sequencer steps into one of 17 Preset Grid 
Memory Slots that can be selected, played, automated and randomized. The FX 
Sequencer is the thin single row sequencer above the Track Sequencer and is made up of 
yellow horizontal steps that determine when the FX GESTURES will be applied. 

FX GESTURE CELL - Stores FX Gestures, generated with each click of the GENERATE 
button, into 17 Preset Grid Memory Slots. The FX Gestures are automatically generated 
dynamic effect movements that ramp and modulate over time, using a suite of creative 
effects. The FX Sequencer determines when those effects take place and the FXON mini-
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cell determines which tracks to send to the effect, while the FX MIX controls determine the 
balance of the effects. The effects that make up a gesture are STUTTER, FILTER, REV, 
GRAIN, TAPE and GATER effects.

While you can’t edit the gestures or the FX parameters themselves, you can generate 
infinite new gestures by clicking the GENERATE button and you can adjust the FX MIX by 
using the small yellow mixer icon, located in the upper right of the Sequencer area. The 
mix settings are not stored with the Memory Slots, but are stored with the Scene.  

When you click GENERATE, 17 new effect combinations with unique signal flow 
ordering are created, along with automated movements of essential parameters.  
Sometimes an effect may be generated that features more of one effect and less of 
another. As such, if you adjust the MIX levels to something other than 100%, it’s 
possible that you may end up with a a GESTURE that is silent on occasion. The 
effects also depend on transients, so if you load a quiet pad sound it may not get 
picked up by the effect engine.  

4.3.3. The Sampler Controls Parameter Cells Defined

Undoubtedly the most import Parameter Cell is the LOOPS Cell as it determines which 
loops are playing back in ULTRALOOP. For that reason the LOOPS Cell remains constant 
regardless of the page you select. 

There are four Parameter Pages with Sampler Parameter Cells that shape the sound of 
each layer. In this section we will define each page and its controls.  

Right-click the Parameter Page labels to reset the entire page’s Parameter Cells to their 
default.

The TIME Page  - The sampler’s timing parameter cells

START: Adjust the loop start playback position for each layer.

LENGTH: Adjusts the Length of each loop for each layer. 

The SPACE Page  - The sampler’s spatial parameter cells

PAN: Adjusts the panning of each layer.

VOLUME: Adjusts the volume of each layer.
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The FILT Page  - The sampler’s filter parameter cells

FILT: Adjusts the filter frequency of each layer. To the right of center is a HIGH PASS filter 
and to the left of center is a LOW PASS filter.

RES: Adjusts the resonance of the filter for each layer.

The ENV Page  - The sample’s amplitude shape parameter cells

The Envelope settings are per-sequencer step. Each active sequencer step re-triggers the 
start of the envelope. 

ATK: Adjusts the attack time for each layer.  The attack is the time it takes for volume to 
reach maximum amplitude per slice. 

HLD: Adjusts the hold time for each layer. Hold time is the time the sound sustains after 
attack, before the decay stage begins. 100% = 1 sequencer step

DEC: Adjusts the decay time for each layer. The decay time is the time it takes for sound 
to reach the sustain level.

REL: Adjusts the release time for each layer. The release time is the time it takes for the 
sound to return to zero (off) once a note has been released or the Trig message ends.
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5. The ULTRALOOP Sequencer Area
The ULTRALOOP Sequencer Area has a Track Sequencer, FX Sequencer, FX Mixer 
and MINI-CELLS. 

5.1. The Track Sequencer

The Track Sequencer is the main ULTRALOOP sequencer. Unlike typical sequencers, 
ULTRALOOP’s Track Sequencer allows you to choose which steps are active for a set of 
loops that are always already playing back (silently) regardless of whether or not a 
sequencer step is active.  This distinguishes itself from most sequencers which usually 
send a message to the sampler to start playing back a particular sample with each gate 
message. 

In some sense, you can think of the Track Sequencer as an effect, that works in a similar 
way to a gate effect or noise gate plugin. When a step is active, signal that is already 
playing back on a track passes through. When a step is inactive, the signal on that track is 
silenced. In this sense, the Track Sequencer is post-sampler in terms of signal flow. Each 
active step can be further shaped using the AHDSR Cells, found in the Sampler Controls 
area’s ENV page.

Drawing in the Track Sequencer

Click and drag to activate Track Sequencer steps
Control-click and drag to erase Track Sequencer Steps

When editing a Parameter Cell or drawing the in the Track Sequencer, a vertical blue line to 
the left of the Track Sequencer indicates which which track is currently selected and the 
corresponding Parameter Cell Slider will become outlined.  This helps you to find the 
controls for each track and vice versa.
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The Track Sequencer Additional Controls

DRAW: Sets the draw mode to MONO or POLY. Mono mode allows you to draw steps on 
one track per division, preventing you from activating layered steps.  POLY mode allows 
you to draw layered sequencer steps freely.

WAVES ON/OFF: Shows and hides the live waveform displays underneath the sequencer 
for the loops that are playing back. 

LEN: Sets the Length in 1/16th note steps of the Track Sequencer pattern. It is important 
to understand that the length of the Track Sequencer pattern is not related to the length of 
the Loops that are playing back. The LEN setting only determines the length of the gate 
pattern sequence, but the Loops are always playing back at their full-length.

The one exception is when the TRIM Mini-Cell is on. When the TRIM Mini-Cell is on, the 
Loop length for all samples playing back is automatically clipped to the Track Sequencer 
Length.  

5.2. The FX Sequencer

The FX Sequencer allows you to apply the FX GESTURES to a track or set of tracks, at a 
specific moment in time. Using the FX Sequencer, you can then determine which steps will 
have effects active and which tracks will be routed to the effects by using the yellow FX 
ON mini-cell. 

The effects are generated automatically by using the FX GESTURE cell’s GENERATE 
button. FX Gestures are automatically generated dynamic effect movements which are 
stored in Preset Grid Memory Slots. The effects that make up a gesture are the STUTTER, 
FILTER, REV, GRAIN, TAPE and GATER effects.

Drawing in the FX Sequencer

Click and drag to activate FX Sequencer steps
Control-click to reset the entire FX Sequencer

5.3. The FX Mixer

The FX Mixer adjusts the dry/wet balance for the individual effects that make up an FX 
GESTURE and the overall dry/wet balance of the entire effect series. You can access the 
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FX Mixer by clicking the small yellow mixer icon, located in the upper right of the 
Sequencer area. 

The mix settings are not stored with the Memory Slots, but are stored with the 
Scene.  

STUTTER:  Dry/Wet balance for the Stutter FX Gesture. 

FILTER:  Dry/Wet balance for the Filter FX Gesture.

REV:  Dry/Wet balance for the Reverse FX Gesture.

GRAIN:  Dry/Wet balance for the Grain FX Gesture.

TAPE:  Dry/Wet balance for the Tape FX Gesture.

GATER:  Dry/Wet balance for the Gater FX Gesture.

FX MIX:  Dry/Wet balance for the entire Gesture FX mix.

5.4. The Mini-Cells Basics

To the right of the Track Sequencer, are the Mini-Cells, a set of controls that give you 
additional track specific settings. You can select the Mini-Cells using the tabs below the 
Sequencer. The Mini-Cells are color-coded to help logically understand their behavior. 
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Blue Mini-Cells are Track Sequencer Mini-Cells. 
Yellow Mini-Cells are FX Sequencer Mini-Cells.
Orange Mini-Cells are Loop playback Mini-Cells.

5.4.1. The Mini-Cell Details

MUTE MINI-CELL:  Mutes Track Sequencer tracks.

SOLO MINI-CELL:  Solos Track Sequencer tracks.

LOCK MINI-CELL:  Protects Track Sequencer tracks so they aren’t affected by 
randomization or drawing. 

You can lock a track and then draw on top of it using DRAW: MONO sequences. 

OUT MINI-CELL: Allows you to route individual tracks out their own unique set of outputs, 
so that you can process them independently using Reaktor effects or you Host DAW.

Please note that FX Gestures are only applied to tracks routed out the MAIN output 
setting. All other output settings have no FX Gestures applied. 

Your host must support multi-out instances of Reaktor to take advantage of the 
multi-out functionality. 

BPM MINI-CELL: Sets the playback speed of the track and also provides access to 
setting the BPM detection range.   

	 NORM = Normal playback speed. 
	 HALF = Half-time playback speed. 
	 DBL = Double-time playback speed. 
	 BPM DETECTION RANGE = Sets the BPM Detection Range for the sample map. If 
	 you load samples that are outside the range, samples will playback at the incorrect 
	 speed. You can adjust the BPM DETECTION RANGE to ensure that the samples 
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	 you playback are detected correctly. A numeric BPM indicator to the left of the BPM 
	 Mini-Cells shows the currently detected BPM. 

PITCH MINI-CELL: Adjusts the sample playback pitch. If OFF, ULTRALOOP will time-
stretch your LOOPS to match the current tempo. If ON, ULTRALOOP will adjust the pitch 
to match the current tempo.

SMOOTH MINI-CELL: Applies smoothing to the Loop engine playback. More smoothing 
may be good when using non-percussive material like pads. The default is LOW and 
should be good for percussive material, however for staccato percussion (like High Hats) 
that has transients that need to cut through perfectly, you may wish to try to use OFF.

TRIM MINI-CELL: Trims the length of a Loop to match the sequencer length. 

	 Imagine that you have three loops playing back. Loop #1 is 4 bars long. Loop #2 is 
	 2 bars long and another Loop #3 is 1 bar long. 

 If TRIM is off, each loop will playback in its entirety, regardless of the Track 
 Sequencer LEN setting, provided that you haven’t shortened it using the Sampler 
 Controls area LENGTH Parameter Cell. This means that loop #1 will repeat every 4 
 bars, Loop #2 will repeat every 2 bars and Loop #3 will repeat every 1 bar, despite 
 the fact that the Track Sequencer gate pattern is cycling every 1/16th. 

	 If TRIM is on and LEN is set to 16, each loop will repeat every 16 steps (1 bar). If 
	 LEN is set to 8, each loop will cycle every 8 steps, etc.

MONO MINI-CELL: Sums track to mono.

PHASE: Inverts the phase (polarity) of the signal.

REVERSE: Reverses playback.

FX ON: Sends a particular track to the FX GESTURE engine for processing. 
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6. Working with Scenes
Each ULTRALOOP Snapshot has eight Scenes, found in the ULTRALOOP footer area. 
You can think of the Scenes as sub-presets contained within each Snapshot. A Scene 
contains all the Parameter Cell settings, Preset Grids, Sequencer controls and additional 
settings. The only settings that aren’t a part of a Scene are the controls found in the 
Master Controls area. Scenes can be played using MIDI, OSC or by selecting a Scene with 
your mouse.

Be sure to select MIDI IN PLAYS: SCENES if you’d like to use MIDI notes to control your 
Scenes. 

In Reaktor standalone mode, you can use your QWERTY keyboard to simulate playing a 
MIDI keyboard.

Fig. 6.0 Scenes

[1] MIDI Mode Selector: When set to MIDI IN PLAYS: SCENES, MIDI input will 
be sent to the Scenes. When set to MIDI IN PLAYS: SLOTS, MIDI in will be sent to 
the a MIDI activated Parameter Cell’s Preset Grid to control the Memory Slots.
[2] Scene Root: Sets the root note (by octave) for MIDI playback of the Scenes. By 
default c3-g3 will playback scenes 1-8. 
[3] Scene Init: Initializes the entire Scene so you can start sound design 
completely from scratch.
[4] Scene Copy: Copies the entire Scene. 
[5] Scene Paste: Pastes the last copied Scene into the currently selected Scene.
[6] Scene Duplicate: Duplicates the currently selected Scene to any other Scene 
you select thereafter without the need to click Paste. To use, simply press Duplicate 
once to activate Duplication. A red light flashes to indicate that you will immediately 
write over any other Scene with the scene you had selected when activating 
duplicate. Select one or more Scenes to duplicate to and then deactivate Duplicate 
to disable. This is a quick way to duplicate Scenes without disrupting your 
workflow.
[7] Scene Selectors: Selects a Scene to playback.
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6.1. The Master Area
The Master Area Contains universal controls which are not stored with the individual 
Scenes, but are stored with Snapshots.  

Fig. 6.1 Master Area

[1] Rnd:  When the Master RND button is triggered, the current Scene is 
Randomized. Clicking the Master Rnd button will only randomize certain aspects of 
your Scene. Which aspects it randomizes depends on which areas are set to 
Master Random Receive. Throughout the interface you’ll find small green dots. 
These green dots are Master Random Receive toggles and determine whether that 
area is setup to receive randomization when using the Master Rnd button.
[2] Master Random Receive Toggle: Toggles all the Master Random Receive 
toggles on or off when clicked.
[3] Single Edit Mode Toggle:  Toggles all the Single Edit Mode buttons on/off. 
[4] Slider View Toggle:  Toggles Slider View on/off for all Sampler Controls 
Parameter Cells. 
[5] Len Adjust:  Adjusts the Length of all LEN controls throughout the Scene.
[6] Pin Toggle:  Toggles the Pin on/off throughout the Scene. 
[7] Record Toggle: Toggles record on/off throughout the Scene.
[8] Play Toggle: Toggles play on/off throughout the Scene.
[9] Root Adjust: Adjusts the Root value for all Root controls throughout the Scene.
[10] MIDI In Toggle: Toggles MIDI IN on/off throughout the Scene.
[11] Swing: Swings the sequencer readout.  
[12] Sync: Syncs Preset Grid Memory Slot playback to quantized value. 
[13] Punch: Applies compression and limiting to the master output to glue the 
signal and keep things from clipping.  A setting of zero will bypass the effect entirely.
[14] Vol: Master Volume control

If you’d like to turn the Limiter off or on for all presets, you can set it to Snap Isolate.  To do 
so, simply right-click the Limiter icon (while in Edit mode), choose ‘Properties’ and check 
the Snap Isolate checkbox in the Functions tab in the Sidepane. Save ULTRALOOP and 
now the Limiter setting is not stored with your Snapshots. 
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7. Advanced Topics
In this section we’ll look at some more advanced topics, such as BPM mode, working with 
external effects and using Reaktor’s built-in recording functions.

7.1. Understanding Time Stretching
When PITCH mode Mini-Cell buttons are active, the layers will stretch to fit the current 
BPM by using Pitch stretching. When PITCH mode Mini-Cell buttons are off, the tracks will 
use slice based time-stretching.  Different tracks can be set to different stretching 
methods. 

Pitch Stretching: 
When PITCH mode Mini-Cells are ON for a given layer, the sample will stretch to fit the 
current BPM by automatically changing the pitch. 

Slice-Based Time Stretching: 
When PITCH mode Mini Cells are OFF for a given layer, the sample will stretch to fit the 
current BPM by using slice-based time-stretching while preserving the pitch of the original 
sample. While these works well if you’re using melodic material and want to keep things in 
key, if you slow down you may here gaps and artifacts. 

7.2. Using ULTRALOOP’s Multi-Outs

You may want to setup ULTRALOOP with your DAW or hardware effects so you can 
process each layer independently. To process ULTRALOOP layers independently directly in 
your DAW, you’ll need to setup a Multi-Out instance of Reaktor in a DAW that supports up 
to eight stereo software instrument outputs (Ableton Live or Logic Pro). You’ll then need to 
turn on OUT Mini-Cells and route your signal accordingly.

Only the AU version of Reaktor supports all 8 outputs. VST instances will only support 3 
stereo outputs.

To process ULTRALOOP layers independently using hardware, you’ll need an audio 
interface that supports 8 stereo outputs.   

Lastly, if you don’t have a Multi-Out capable host or simply prefer to use Reaktor in 
standalone mode, you can route signal between applications using something like 
Soundflower by Cycling74 for the Mac or JackAudio for Windows.

http://cycling74.com/soundflower-landing-page/
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http://jackaudio.org/download

To use ULTRALOOP’s Multi-Outs with your host:

1. Open ULTRALOOP’s OUT Mini-Cell tab.

2. Choose a setup of unique outputs in the OUT Mini-Cell for each layer.

3. In your host software, create a 8 x Stereo multi-out instance of Reaktor.

4. In your host, create auxes or audio channels to receive outputs you selected in the 
OUT Mini-Cell.

To use ULTRALOOP’s Multi-Outs with your hardware:

1. Open Reaktor in standalone mode or in your DAW as an 8 x Stereo multi-out 
instrument.

2. Open ULTRALOOP’s OUT Mini-Cell tab.

3. Choose a setup of unique outputs in the OUT Mini-Cell for each layer.

If you’re using a DAW, create auxes or eight stereo audio channels to receive outputs from 
Reaktor and route their outputs to your desired to the desired hardware effects.

To use ULTRALOOP’s Multi-Outs with Soundflower:

1. Open Reaktor in Standalone mode.

2. Open ULTRALOOP’s OUT Mini-Cell tab.

3. Choose a setup of unique outputs in the OUT Mini-Cell for each layer.
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4. Go to Reaktor’s File > Audio & MIDI Settings and choose Soundflower 16 Channels 
from the main device.

5. Go to your host software and setup Soundflower or JackAudio as the input device.

6. Setup Audio channels in your host to record inputs from Soundflower.

7.3. Using Reaktor’s Recorder 
While ULTRALOOP can be played live inside a host, it is more CPU efficient and often 
times more practical to simply create sounds in ULTRALOOP and record them as audio to 
use in your host.

Reaktor has an amazing built-in tape recorder that allows you to instantly create recordings 
of your loops and drag & drop audio them from Reaktor directly to other hosts such as 
Ableton or Maschine. You can even drag & drop audio from Reaktor while it is running in 
plug-in mode!

We highly recommend that you check this out, as it is a great way to make kits.

To record ULTRALOOP sounds as audio and drag and drop them into your host:

1. Open up ULTRALOOP and find a sound you like.

2. From within Reaktor, File>View > Show Player and Recorder.

3. Click where it says ‘Untitled Audiofile’ and name it something relevant (ULTRALOOP 
01).

4. Click the Settings icon on the far right and choose ‘Record Start by: Clock Start’ and 

‘Record Stop by: Loop Length’ and set the Loop Length. 
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5. Click OK. 

6. Hit the record button on the Recorder. 

7. Hit Play in Reaktor (or your host).

8. Drag the Audio file to your host by using the drag icon.

9. Rinse and repeat.  
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8. Using Controller Templates
ULTRALOOP comes with an OSC template for iPad’s Lemur designed by Lemur expert 
Antonio Blanca. This is by far the best way to control ULTRALOOP. 

Additional documentation on how to setup the template can be found in the 
Documentation folder in the Reaktor and Lemur OSC Setup Guide.pdf. 

To use the OSC template for Lemur, you’ll need to get the Lemur application for your iPad 
and the Lemur editor for your Mac or PC which is sold separately.

http://liine.net/en/

http://liine.net/en/support/lemur

8.1. MIDI Mapping
If you prefer to use standard MIDI mappings and your own controller, you can easily setup 
MIDI mappings yourself as we’ve left those controls free.

ULTRALOOP has several hundred controls. Unfortunately, it is impossible to map all of 
them due to restrictions with Reaktor and MIDI, which is why we recommend you use 
OSC and the included Lemur template by Antonio Blanca. However, many controls can be 
mapped to MIDI.

Making your own MIDI Assignments Using MIDI Learn

Many parameters like the Sliders in ULTRALOOP can be right-clicked to activate MIDI 
learn. Move a controller and it should learn it automatically, provided that your Audio&MIDI 
settings are setup correctly. 

This kind of assignment will be saved with the Reaktor ensemble, so save a backup in case 
you’d like to revert to the original!

          MIDI Templates

                                       ULTRALOOP USER GUIDE - PAGE 44

http://liine.net/en/
http://liine.net/en/
http://liine.net/en/support/lemur
http://liine.net/en/support/lemur


9. Troubleshooting and FAQ
Sometimes you might run into trouble when using ULTRALOOP. In this section we’ll go 
over some of the common issues you might encounter and how to resolve them.

Can I use the Reaktor Player with ULTRALOOP

No, ULTRALOOP requires the full version of Reaktor and won’t run with Reaktor 
Player. 

Can I use my own samples?

Of course you can. Just open the Reaktor Sample Map Editor while in Edit mode. 
Click the structure icon next to the main snapshot menu to turn on Edit mode. 
Check out the Using your own samples section of this guide for more 
information. 

Why can’t I add my own samples and click the folder to edit my map?

You’ll need to turn on Edit mode in order to edit ensembles like ULTRALOOP. Click 
the structure icon next to the main snapshot menu to turn on Edit mode.

I can’t hear anything.

Is Reaktor setup as an instrument (plug-in mode only)? 
Have you setup your Audio & MIDI Settings under File>Audio & MIDI Settings 
(standalone mode only)?
Have you turned the Reaktor Volume knob down by accident?
Have you accidentally randomized the Volume cell or your Envelope Cells?

All my loops are playing at the wrong speed in BPM mode.

Sometimes the BPM detection interprets slow loops or fast loops incorrectly as 
being half-speed or double speed. If this is the case, click the BPM Mini-Cell and 
adjust the speed factor for the layer that is playing at the wrong speed or set the 
BPM Detection Range appropriately.

No matter what, all I hear is one layer.

Is SOLO mode on? 
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I’m trying to activate a step in the sequencer, but it won’t let me!

Is the track Locked? If there is a Lock icon, it means you’ve protected the track 
using the LOCK Mini-Cell.

I can’t see the detected BPM!

Adjust the sequencer length to be the full 16 steps as it affects the display of the 
BPM.
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